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INTRODUCTION 

Welcome to Save the Cat! 3.0. Version 3.0 offers many exciting new features as well as a redesigned user interface that 
gives you a lot of flexibility in setting up your own workspace.  There are so many new features that we decided to write 
a full user guide rather than just including program tips because we don’t want you to miss anything. 

WHAT’S NEW? 

There are so many new features we will list just a few. But, you can learn about all of them in this user guide so keep 
reading. 

New User Interface 

The user interface has been redesigned so that everything is in one window with sections for the title and logline, beats, 
The Board, the Litter Box, and a new notes corkboard. Each of these sections can be sized and even hidden to make just 
the right amount of room for exactly what you want to see. 

You can change the size of The Board both vertically and horizontally to make it as large as you like. You can even make 
it larger than your monitor will allow. Just scroll horizontall or vertically to see the part of The Board you need to see. 
And, your cards are no longer locked into a vertical position within a section. You can “pin” them anywhere on The 
Board, just like a real corkboard. 

File Format 

We have changed the file format for Save the Cat! 3.0 files so they are fully compatible between Windows, Mac, iPhone 
and iPad. So, no more exporting for the Windows version or Mac version and importing the file back in. To move a file 
from one platform to another, you’ll copy the file just like a Word document. 

General Notes 

We’ve added a new section, a corkboard, for attachments and note cards. What does this mean? Maybe you’re writing a 
period piece and you’ve found a picture of an old house that fits perfectly for the location for a scene. Drag and drop it 
into this new section and a note card, with the picture, will be pinned to the corkboard. You can give it a title and 
description and even attach it to a scene card, a character, or a location (more about those later). 

You can attach nearly any kind of file: pictures, pdf’s, documents, spreadsheets, sound files, video files. You can even 
highlight text and images in a web page and drag and drop them here.  

You can also add notes by double-clicking on the corkboard. A note will magically appear where you double-clicked. 
Type a title and the note then place it wherever you like. 

Oh, and you can color code these attachments and notes using one of ten different colors. 

Beats and Beat Cards 

Drumroll please! Many of our users made a particular request and we listened. The scene cards that get automatically 
created for the beats remain linked to the beat. So, if you change the description for the beat, the description in the 
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scene card changes. And, if you change the description for a beat scene card, the description for the beat will be 
automatically updated. 

Characters 

You can now add a list of characters for your story and enter such information as their gender, age, description, wants 
and needs, and the “Six Things That Need Fixing.” And you can link attachments to a character. You can even identify 
one of the attachments as the primary image for the character. So, if you find a picture that looks like the character you 
have in mind, you can attach it the corkboard then link it to the character and the image will be there to inspire you. 

When you create characters, you can drag and drop them onto the appropriate scenes so you can keep track of which 
characters are in which scenes. 

Locations 

Like characters, you can now add a list of locations where your story takes place. You can give the location a title and a 
description and link attachments. If you find a picture or a map for one of your locations, link it to the location and 
assign it as the primary image for that location.  

And, just like with a character, drag and drop a location onto the appropriate scene cards that take place at that 
location. 

Scene Cards – List View 

We’ve added a new way to view your scene cards that is much like the list of scene cards you see if you use the iPhone 
version. You can view them chronologically (we’ve added new fields for the starting date/time and ending date/time for 
a scene) and filter the list by color code (oh yeah, you can have as many different color codes as you want now) and/or 
by character and/or by location. That means you could review only the scenes that include a particular character. You 
know, make sure the star has enough screen time. 

Save the Cat! Strikes Back 

We’ve added the option to have Save the Cat! 3.0 add new default scene cards for you along with the basic 15 beat 
cards. As described in Save the Cat! Strikes Back, these additional cards are in the Setup, Debate, Fun and Games, Bad 
Guys Close In sections, and the Five Point Finale cards. 

We’ve also included the Greenlight Checklist from Save the Cat! Strikes Back so you can make sure you are really ready 
to go when you start to pitch your story. 

WHAT THIS GUIDE IS NOT 

This user guide is not a tutorial as to the Save the Cat! methodology. See the next section of this user guide to find out 
about the resources we’ve provided to help you write a great screenplay or story. 

Now, let’s get started! 
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GETTING STARTED 

ACTIVATING 

The first time you start Save the Cat! 3.0, you will be required to 
activate. 

ACTIVATE VIA THE INTERNET 

If you have an Internet connection, activating via the Internet is the 
quickest way to get going. Enter your serial number and click the 
Activate Only button. If you would also like to register so we can find 
your serial number for you if you lose it, fill in the additional 
information and click the Activate and Register button. 

Save the Cat! 3.0 will connect with our server and validate your serial 
number and check whether you have activations left. You are allowed 
to activate on two computers. But, we understand when computers 
crash or you get a new computer and may need an additional 
activation. We will work with you to keep you creating great stories. 

 

ACTIVATE VIA EMAIL 

If you don’t have an Internet connection or are unable to activate via 
the Internet due to a firewall or proxy server blocking the 
connection, you may activate via email. Send your serial number and 
the Computer Code that shows on the Activation window on your 
computer to tech@blakesnyder.com. We will process the 
information and send you an email with the activation code that you 
will enter at the bottom of this window along with your serial 
number to activate your copy of Save the Cat! 3.0. 

UPGRADING 

If you are upgrading from a previous version, all of your screenplays 
will automatically be upgraded to the new file format and saved in 
My Documents. 

 

DEACTIVATING 

If you need to deactivate your computer so you can activate another computer, click the Help menu then the Deactivate 
menu.  Save the Cat! 3.0 will connect with the server, deactivate your computer and end the program. 

mailto:tech@blakesnyder.com
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OTHER IMPORTANT ITEMS 

All of these items can be found under the Help menu. 

SAVE THE CAT! TUTORIAL 

The Save the Cat! Tutorial provides a lot of great information about the Save the Cat! methodology. If you’re not familiar 
with Save the Cat! concepts and want to write a great screenplay, you should read the tutorial.  

SAVE THE CAT! STRIKES BACK – CHAPTER 3 

That’s right! Chapter 3 of Blake Snyder’s book, Save the Cat! Strikes Back, has been included for you to read. 

ABOUT SAVE THE CAT! 

Check here if you need to look up your serial number or see what version of the program you have. 

CHECK FOR UPDATES 

Use this to make sure you are running the latest and greatest version of Save the Cat! 3.0. We are continuously making 
improvements to the program and you’ll want to be sure and stay up to date. 

VISIT THE SAVE THE CAT! WEBSITE 

We even provide quick access to the Save the Cat! website. Click here to go directly to the website in your browser. 
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NEW USER INTERFACE 

MAIN WINDOW 

The main window, naturally, is where you start. Not much there 
as you can see. Until you start a new file. 

The File menu items are bit different, however, than you may be 
used to seeing in other applications. Here are the 
interpretations. 

 

 

START FRESH 

Start a brand new file. Just like the standard File/New menu. You can also 
click the New button on the toolbar to start a new file. 

PICK A FILE, ANY FILE 

Open an existing file. 

PICK UP WHERE I LEFT OFF 

This menu is like the Open Recent menu in other applications. You will see a list of up to four of the most recently 
opened files. 

RETRIEVE FROM THE CLOUD 

This menu is used to copy a file from one computer to another computer or device. More on this later. 

RETRIEVE FROM SAVE THE CAT! IPHONE V.1 QUEUE 

Use this until the new iPhone version of Save the Cat! is available to transfer a project from your iPhone to your desktop. 
A new, Version 3 Save the Cat! file will be created. 

IMPORT 

This menu is used to Import a file from a previous version of Save the Cat! Or, from a Final Draft 8 script. More on this 
later. 

SHUT ER DOWN 

Close the open files and exit Save the Cat! 3.0. 
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CONFIGURING THE INTERFACE 

We need an open a file for this. So here’s what the new interface looks like with a file opened. 

 

If you’ve used earlier versions of the program, some of the changes should be jumping out at you. The window is divided 
into five sections: Title and Logline, Beats (etc.), The Board, Litter Box, and Notes.  

SIZING A SECTION 

Each of the four sections can be resized simply by moving the divider between sections. Just left-click and hold on the 
raised brown dividing line between two sections and drag it to move it. Here’s what the window looks like with a larger 
Title and Logline section. 
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The only section that has a limitation is the Litter Box. The width is limited to the width shown. But, you can hide it 
completely. See the next section of this document to learn how to hide sections. 

HIDING A SECTION 

You can instantly hide a section using the buttons on the toolbar or the menu items under the View menu. The View 
menu shown below illustrates very well the meaning of each of the appropriate toolbar buttons. 

 

 

 

The first four items shown allow you to 
instantly hide a section. When you click 
the menu or toolbar button to hide a 
section, the menu will switch its 
function to show the section. 

So, click the toolbar button again to 
make the section visible.  
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EXPAND A SECTION 

You can also, instantly, fill the window with one section and hide all the others. For example, if you only want to see the 
Board so you can take full advantage of the size of your monitor, click the Full Board View toolbar button and everything 
but the Board will be hidden. 

 

Now you are in Full Board View. You can switch to a “Full” window view for the Board, Title and Logline, Beats (etc.), or 
the Notes sections. 

Here’s what the Full Beats (etc.) view looks like. 
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RESTORE THE VIEW 

If you want to restore the original view you had before switching to “Full” view, click the Restore View toolbar 
button.  

FONT SIZE 

You can now increase and decrease the font size for most everything but the Board (that’s handled a little differently) to 
one of four different font sizes. You’ll find the settings under the Edit menu as shown below. 

 

ZOOM THE BOARD 

As stated above, The Board font size is handled a little differently. When you increase or decrease the zoom for The 
Board to one of the four sizes, The Board itself grows as do the individual scene cards on The Board. And, of course, the 
font size for the beat sections and the scene card fields increases or decreases as well. 

The Zoom option for The Board is found under the View menu. 
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RESIZE THE BOARD 

In addition to zooming the view of The Board, you can also change the size of The Board itself so that you can fit more 
cards side by side and even avoid overlapping cards. You can size it both vertically and horizontally. And, no need to 
worry how big you make it because you just use the scroll bars to move the viewable area into view. 

The settings can be found under the Edit menu. 

 

Fit to Current View – Use this setting to size The Board to match the actual viewable area. This is great if you have a 
large monitor and want to see the entire Board without having to scroll. The Board will be set to match the width of the 
viewable area. But, the height will be set no smaller than four scene cards high plus the height for the dividers.  
Remember, if the viewing area is very narrow, the beat sections could become unreadable and the scene cards will 
overlap a lot. 

Increase Width by 10% / Increase Height by 10% - As you can guess, these items will add 10% to the current width or 
height. 

Decrease Width by 10% / Decrease Height by 10% - Again, these items will decrease the height or width by 10% with 
the limitation on the height of the four scene cards. Both height and width are limited to the size of the viewable area.  
You cannot decrease them to less than the size of the viewable area. 

Restore Defaults – If the size has gotten out of control, use this setting to restore The Board size to the height of four 
scene cards and the width of ten scene cards. 

If you use the dividers to resize The Board section or the Full Board View toolbar button and the size of The Board is too 
small for the new viewable area, the height and width will be automatically increased as needed to fit into the viewable 
area. 
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RESIZE THE NOTES SECTION 

You can also resize the corkboard for the Notes section. The Notes corkboard works very similar to The Board in that you 
scroll to view the entire corkboard.  These options are also found under the Edit menu. 

 

Again, the minimum size is limited to the viewable area.  And, if you use the dividers to resize the Notes area, or use the 
Full Notes View toolbar button and the size of the Notes corkboard is smaller than the viewable area, the height and 
width will be automatically adjusted as needed to fit into the viewable area. 
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SECTION DETAILS 

TITLE AND LOGLINE SECTION 

As you may know, Save the Cat! methodology requires that you determine your title and logline before moving on to the 
15 beats and nailing down your 15 beats before moving on to The Board. So, the Title and Logline section is the place to 
start.  There’s really nothing to say about typing in your title or picking the genre, but something new to Version 3.0 is 
that you can write multiple loglines.  

MULTIPLE LOGLINES 

Writing a good logline is very important so we’ve made it easier to brainstorm by allowing you to write and save 
multiple loglines. When you start a new file, the first blank logline is set up for you so you can just start typing. But, if 
you want to add another logline, click the log on the toolbar and you will see some options. 

 

Click the Blank Logline menu to start from scratch. Remember (as pointed out in the Save the Cat! books and this 
software’s manual), the four key elements of an iron-clad logline! 

LOGLINE FROM TEMPLATE 

We have also added the two templates from Save the Cat! Strikes Back to help you take your logline to the next level. 
These do not give you that simple, pithy logline you’ll want, but they can help you vet your idea to make sure it works. 
The short form template looks like this. 

 

And the long form template looks like this. 

 

In both cases, when you put the cursor in front of one of the fields shown in []’s, the field will be highlighted for you so 
when you type your own text, the fill-in field will be replaced by your own text. 

Once you have more than one logline, a My Loglines button appears to the right of the logline fill-in box. Click this log to 
see a list of all of your loglines as shown below. 
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My first logline is still blank. If you want to switch your current logline to one of your other loglines, just check the box in 
the “Current” column.  The selected logline will be filled in for you in the Title and Logline section when you close this 
window. You can switch loglines as often as you like until you’ve nailed it. 

And, of course, you can delete the stinkers, too. 

PAGE COUNT 

Turns out novelists have found Save the Cat! to be an effective tool for their work, so we’ve increased the maximum 
number of pages to one thousand. I don’t think anyone reads thousand page novels anymore so, hopefully, that will 
work for all the novelists out there. And, if you think you want to write a thousand page screenplay, don’t forget that 
one page generally equates to one minute on screen. Oh, and the minimum number of pages is four, one page for each 
section of The Board. 

When you change the page count, the beat sections will be automatically reconfigured and the page numbers will be 
adjusted for all of your scene cards. 

BEAT SECTION 

When we refer to the Beats section, we are including the Characters, Locations, Setups and Payoffs as well. 

BEATS 

Once you have filled in your title, logline, and genre, you can begin filling in the beats. Just click in the white box in the 
list to enter or change a beat. Once you complete all 15 beats, you will be prompted to select optional scene cards that 
will be added along with the 15 beat cards. 

And, if you change the description for a beat after the scene cards have been created, the description for the 
appropriate scene card will be updated automatically. And, if you change the description in a scene card that is linked to 
one of the beats, the beat description will be updated automatically. 
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CHARACTERS 

While you must complete the title and logline before you can work on the beats, you can enter characters at any time. 
To view your list of characters, click the Characters tab. Initially, the character list will look like this. 

 

But, when you click the Characters tab, a new button will appear on the toolbar and a new menu item will appear under 
the Screenplay menu. 

          

ADD A CHARACTER              

Click the toolbar button or use the Add Character menu to add a new character. The character detail section will be 
displayed. 

For more details regarding the wants, needs and six things that need fixing, 
see the tutorial or the Save the Cat! books. 

Add Attachment 

The image that is shown is just a default image for a character. But, you can 
drag and drop attachments from the Notes corkboard into the Attachments 
list for a character, then assign one of those attachments to be the primary 
display image for the character. It could be an actual image or the icon of an 
attached file such as a pdf.  

Or, if you’ve found a photo that depicts the character you have in mind, you 
can have that photo displayed whenever you look at the character list or 
character details.  

Remove Attachment 

To remove an attachment from a character, just drag it from the 
Attachments list back to the Notes corkboard and drop it. Or, select it in the 
list and press the Delete key. 

Close Character Details 

To close the character details view, just click the X in the upper right corner. 
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VIEW CHARACTER DETAILS 

Just click on a character in the Characters list to view the character details. 

DELETE A CHARACTER 

When you view the character details, a new toolbar button appears. Click the button with the red “X” to 
delete the selected character. 

ADD A CHARACTER TO A SCENE 

Adding a character to a scene from the characters list is as easy as dragging the character name from the list and 
dropping onto the appropriate scene card. Or, while viewing the character’s detail information, click and drag in the 
detail panel (any open space will do). You can add a character to as many scenes as needed. 

LOCATIONS 

The Locations section works much the same as the Characters section.  

ADD A LOCATION 

When you click the “Locations” tab to view the list of locations, a button will appear on the toolbar. 

  

Click the lighthouse button to add a Location. The location detail view will be displayed. 

 Add an Attachment 

The lighthouse is the default image for a location but, just like for a character, 
you can add an attachment by dragging it from the Notes section and dropping 
it onto the Attachments list. The first attachment will automatically become the 
primary image but you can change the primary image as you add more 
attachments. 

Remove an Attachment 

You remove an attachment by dragging it from the Attachments list and 
dropping it back onto the corkboard in the Notes section. Or, just select it in the 
list and press the Delete key. 

Close Location Details 

Click the X in the upper right corner. 

VIEW LOCATION DETAILS 

Click a location in the Locations list to view the details. 
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DELETE A LOCATION 

Click the lighthouse button with the red “X” on the toolbar while viewing the Location details. 

ADD A LOCATION TO A SCENE 

Drag the location from the Locations list and drop it onto the applicable scene card. Of course, you can add the location 
to as many scene cards as needed. 

SETUPS/PAYOFFS 

Setups and payoffs work the same, so we’ll deal with both of them together using Setups for our examples. In previous 
versions of Save the Cat!, you could only add setups and payoffs to scenes. Now, to give you a place to capture your 
thoughts about setups and payoffs before you have finished your beats, you can add setups and payoffs without linking 
them to the scene in which they will occur. Then, when you have the scene card ready, you can add the setup or payoff 
to the scene by dragging and dropping it onto the appropriate scene cards. And, you can have multiple setups and/or 
payoffs in each scene but a setup can only be linked to one payoff and vice versa. 

ADDING A SETUP/PAYOFF 

When you click on the Setups tab to view setups, a button will appear in the toolbar with the image of a key. If you click 
the Payoffs tab, the image will be a dollar bill. Get it? A payoff! 

Click the appropriate toolbar button to add the setup/payoff. Setups and payoffs do not have a detail section since there 
really isn’t anything to say about them except to describe the setup or payoff. So, the new item is created and added to 
the list where you can enter the description directly. 

LINK TO A SCENE 

Once you have decided in which scene this setup should 
occur, you simply drag it from the list and drop it onto the 
scene card.   

Once a setup is hooked to a scene, the list displays the scene heading and page number for the linked scene. And a 
green arrow appears indicating that you can jump directly to the scene. 

JUMP TO SCENE 

Click the green arrow and the scene card will be displayed 
in the Big Scene View (more on that later). 
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LINK TO PAYOFF 

If no payoffs exist, you obviously can’t link the setup to a payoff. But, if you have created any payoffs that have not been 
linked to a scene yet, the setups list will look as shown below. 

 

Click the chain link to display a list of unlinked payoffs, as shown below, from which to choose. The list will display any 
payoffs that have not been linked to a scene in the top of the list in a section titled “Free Payoffs.”  

Other payoffs that have been linked to scenes will be displayed in the appropriate beat section based on the scene to 
which they are linked. 

In this example, there is one “Free Payoff” and there is another 
payoff linked to a scene in the “Bad Guys Close In” section. Click 
the payoff in the list you want to link to the setup. 

After linking a payoff to a setup, the list will look like this. 

 

UNLINK THE PAYOFF/SETUP 

When a setup is linked to a payoff, an image is displayed of a 
chain link with a little explosion at the joint. Click this image to 
break the link between the setup and payoff.  

 

DELETE A SETUP/PAYOFF 

Click the key button on the toolbar with the X over it to delete a setup. Click the dollar bill button with the X over it to 
delete a payoff. 
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NOTES AND ATTACHMENTS 

The notes and attachments section is the section along the bottom of the main window. It is the section that has the 
Greenlight Checklist in it in some of the screen shots. This section allows you to add note cards or files and pictures. This 
is a great place to put pictures and files that you have collected while researching your story.  Or, you can use this 
section to put in reminders for yourself so you don’t forget great ideas. 

NOTES 

ADDING A NOTE 

Adding a note is easy. Just find a blank spot on the corkboard and double-click. A note card will be added at that spot. A 
note card has a title which defaults to “New Note Card” and a notes section below the line. 

 

Notice the tooltip that appears when you hold the mouse over the note section. You can change the font and color of 
the text in your notes. Remember though, if you are using the iPad or iPhone version and transferring your file, the iPad 
and iPhone versions are not able to display the fonts and colors in an editable fashion. So, plain text will be used to 
display your note and you won’t be allowed to alter the notes. You can always add new notes though. 

DRAGGING AND DROPPING 

You can also add a note by dragging and dropping text from a web page or from a Word document or other text type 
source. Highlight the text then drag it and drop it onto a blank space on the corkboard. If possible, the formatting from 
the original will be retained. The example below shows the first part of this paragraph. 
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Some text will format better than others. That depends upon the source. So, if it doesn’t look exactly the same as the 
original, there really isn’t anything we can do about that. 

CUTTING AND PASTING 

In a similar fashion to dragging and dropping, you can also copy the original text in the original source then right-click on 
an open space in the corkboard to create the note. 

MOVING A NOTE 

You may be able to guess how you move a note. Left click and hold the mouse button down and the thumbtack will pop 
up. Then drag the note to the new location and release the mouse button. The thumbtack will poke back into the 
corkboard. 

RESIZING A NOTE 

Notice the little lines in the lower right corner of the note card? Click and hold your left mouse button then drag to 
resize the card. 

CHANGING THE COLOR 

You can also change the color of your note cards to one of 10 different colors. Click the color selector button in the 
upper left corner of the card and the note card color selection window will be displayed. Just click on the color you want. 

DELETING A NOTE CARD 

Click the red X in the upper right corner of the card to delete the note card.  

ATTACHMENTS 

Attachments are files and pictures that you can attach to your story. Many different kinds of files can be attached. But, 
there are some that are not allowed to be attached such as programs and dll’s and so on. Still, you should be able to 
attach nearly any kind of file you would think of to attach to an email such as pdf’s, Word docs, Excel spreadsheets, all 
kinds of images, videos, sound files, and text files.  

Remember that your Save the Cat! 3.0 file contains these other files and will grow accordingly. Your file could get quite 
large and take longer to transfer to your iPad or iPhone if you have a 
lot of attachments. 

ADDING AN ATTACHMENT 

The first method is to simply select the file or files in Windows Explorer 
and drag and drop them onto the corkboard. One attachment card will 
be created for each file. Then give it a title and description.  

CUTTING AND PASTING 
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The second method is to copy the selected files then right-click on an empty spot on the corkboard. An attachment card 
will be created for each file you have copied. 

IMAGES 

If the attachments you add are images, a thumbnail will be displayed on the card. But, 
if you double-click the thumbnail, the description will be replaced with the full image. 
You can then resize the card to resize the image. 

 

Double-click the full image to return to the thumbnail/description view. 

FILES 

If the attachment is not an image but another type of file such as a pdf or a 
Word document, you can double-click on the icon to open the file in its 
native application.  

MOVING, RESIZING, CHANGING COLOR, DELETING 

These functions are exactly the same as for Notes, so see the instructions above to do these things. 

CHARACTER ATTACHMENTS 

If you find a photo, for example, that represents a character, you can attach the photo to the character and use it as the 
primary display image for the character. You can attach multiple files and photos to a character but one is always 
designated as the primary image. 

To link the attachment to a character, click the Characters tab in the Beats section so you are viewing the characters list. 
Or, click the specific character so you are viewing the character details and scroll down to the Attachments section. 

Then, right-click and hold on the attachment’s thumbtack then drag and drop it on the character in the list, or onto the 
attachments list in the character detail section.  

If this is the first attachment for a character, the image will automatically be designated as the primary display image. 
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LOCATION ATTACHMENTS 

Maybe you’ve found a picture of a scary old house for 
your horror movie. You can do the same thing you did 
with a character image to attach the picture to a 
location. Right-click and hold on the thumbtack then 
drag the attachment and drop it onto the location in 
the list, or into the attachments list of the location 
detail view. 

 

SCENE CARD ATTACHMENTS 

We haven’t touched on scene cards but here’s a bit of a preview. You can 
also link attachments to scene cards.  And, just like with characters and 
locations, you can link more than one attachment and designate one as the 
primary display image.  The image or icon, if the attachment is not an 
image, will be displayed on the scene card. 

 

THE BOARD 

The Board is where you plot out the scenes for your 
story. Of course, you can only move to The Board 
after you’ve completed your title, logline, genre and 
beats. But, once you do, Save the Cat! 3.0 will 
automatically add a scene card for each of the beats 
for you. These scene cards remain linked to the 
specific beat so, if you change the beat description, 
the scene card description will be updated and, if you 
change the description on the scene card, the beat 
will be updated. 

But, before the beat cards are added, you have the 
option to add additional scene cards to help you get 
started.  

Just check the optional scene cards you would like to include then click the Proceed button. 

Once you have scene cards, there are three ways you can view them. 

CORKBOARD VIEW 

The corkboard view is just what you would expect. The corkboard is divided into the four main sections of a story and 
each section is divided further into beat sections. The difference between this corkboard and the corkboard in earlier 
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versions of Save the Cat! is that you can change the size of this corkboard both vertically and horizontally. And, you’re 
not limited to the viewable area. You can make it as large as you like then use the scroll bars to pan the corkboard 
around. You learned how to do that earlier in this user guide so we won’t repeat it here. 

ADDING A SCENE CARD 

Even though Save the Cat! 3.0 gets you started by creating some scene cards for you, you’ll need to create many 
more scenes to complete your story. To add a new scene card, click the Add Scene Card button on the toolbar. 

 Or click the Screenplay menu then the Add Scene Card menu. When you add a new scene card, the new card is 
automatically opened in the Big Scene Card view. We’ll come back to that later.  

In this view, you can change the scene heading, page number, description, notes (click the N tab on the right), emotional 
change, emotional change type, conflict, and color coding. If you want to work with characters, the location, 
attachments, setups and payoffs, or write the script, you’ll need to switch to the Big Scene Card view. More on that 
later. 

COLOR CODING 

You can identify up to six different colors for a scene card. The color coding is 
displayed in the six little boxes that run down the left side of each card. To 
set a color for a scene card, click in one of the six boxes and the Color Coding 
selector will be displayed. 

Click on a color to select it. 

Or, click the Clear Color button to remove the color coding for the selected 
color coding box. 

INDICATORS 

A scene card may also display certain indicators. If a scene has characters, the 
characters indicator will be displayed in the title bar of the scene card. If a scene has one or more setups and at least one 
of the setups does not have a payoff, a red setups indicator will be displayed. If all of the setups have payoffs, a green 
setup indicator will be displayed. If a scene has one or more payoffs and at least one of the payoffs does not have a 
setup, a red payoffs indicator will be displayed. If all the payoffs have setups, a green payoffs indicator will be displayed. 

MOVING A SCENE CARD 

Moving a scene card is just like moving an attachment or note card. Just left-click and hold on the thumbtack then drag 
the card to its new location. And, unlike in previous versions, the card won’t snap to the border line in the section when 
you release the mouse button. The card stays wherever you leave it. So, you could make The Board tall enough to stack 
two or more cards in the same section.  

One other thing. When you move a card around on The Board, the page number will be changed for you automatically. 
And the page number is updated for you based on where the thumbtack is located. If the thumbtack is above a section 
dividing line, the page number will reflect the appropriate page number from the section above the line. If the 
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thumbtack is below a section dividing line, the page number will reflect the appropriate page number for the section 
below the line. 

DELETING A SCENE CARD 

Click the red “X” in the upper right corner of the card to delete it. 

MOVE TO THE LITTER BOX 

Instead of deleting a scene card, you may want to keep it but move it off The Board. The 
Litter Box is the place for that. To move a card to the Litter Box, right-click the thumbtack 
and hold then drag the card and drop it anywhere in the Litter Box. It will be removed 
from The Board and displayed in the Litter Box in the beat section where the card came 
from. 

 

To move the card back to The Board, just right-click and drag it back and drop it onto The 
Board. The card will not return to its original location on The Board but will be pinned 
wherever you drop it. 

LIST VIEW 

Another way to 
view your scene 

cards is the List view, 
which is similar to the 
iPhone application. To 
switch from the 
Corkboard view to the 
List view, click the List 
View button on the 
toolbar or click the 
View menu then the 
Board menu then the 
List View menu. 

To reset the 
view to the 

corkboard view, click 
the thumbtack button 
on the toolbar. Or, use 
the View menu. 

The List view allows you to sort and filter the list of scene cards. 
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SORTING 

You can sort the list in scene card order, which is the order they appear on The Board, or chronologically. You can now 
enter a start date/time and an end date/time for a scene.  Maybe you have a flashback that is revealed over several 
scenes. You can enter the starting and ending date/time for the scenes then use the Chronological sorting to see those 
scenes together.  

All the scenes that don’t have a starting and ending date/time will be sorted to the beginning of the list. And, when you 
sort chronologically, the scene cards will be out of order in relation to the beats so the Act and Beat section headings will 
not be shown. 

FILTERING THE LIST VIEW 

You can filter the list of scene cards using a combination of a color code, a character, and/or a location. You don’t have 
to select all three but you can select any combination of the three items.  

Click the color box to select from your list of color codes to view only the scene cards that have that color selected. Use 
this to track a character arc or theme through your entire story. 

Select a character from the list to see only the scenes in which that character appears.  

Select a location from the list to see only the scenes that take place at the selected location. 

Or, again, use a combination of all three.  As you make your selections, the list will automatically be refreshed. Finally, 
just clear the selections to show all of your scene cards. 

MOVE TO THE LITTER BOX 

Use the same method as moving a scene card from The Board to the Litter Box. Right-click and hold on the thumbtack 
then drag the card and drop it onto the Litter Box. 

When you move a card back from the Litter Box into the List view, the card will be returned to its original location since 
there is no corkboard to drop it onto. 
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BIG SCENE CARD VIEW 

When you add a new scene card, the new scene card will automatically be opened in the Big Scene Card view. This view 
is where you can get at all the information for the scene including the starting and ending date/time, the location, the 
characters, the setups, the payoffs, attachments and the script. 

You can also get into the Big Scene Card view by double-clicking on the title bar of a scene card on The Board or in the 
List View. 

 

MINI SCENE CARDS 

So that you can see the current scene within the context of the story, we display all the scene cards in a strip along the 
bottom in the order they would appear on The Board. The current scene is highlighted while all the other scene cards 
are grayed out. 

Just click on a mini scene card to display it in the Big Scene Card view. 

NAVIGATING 

You can move to the next scene card or the previous scene card by clicking the pointers on either side of the thumbtack. 
If no left pointer is visible, you are viewing the first scene card. If no right pointer is visible, you are on the last scene 
card. The mini scene card is automatically selected when you use the pointers to navigate. 

CLOSING BIG SCENE CARD VIEW 

To return to The Board or List view, click the black “X” in the upper right corner of the Big Scene Card. 
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COLOR CODING 

Use the same technique to color code the scene card by clicking in one of the six color code boxes down the left side of 
the card. 

NOTES 

This is where you can select the location (if you haven’t already used the drag and drop technique from the locations 
list), set the starting and ending date/time, and modify your notes. 

SETUPS 

This is where you can add, edit, and delete setups for the scene.  

 

The sample shown above has the “Show All Available Setups” box checked. Checking this box will add all setups that are 
not linked to a scene to the list. You can then check the “Included” box to link the setup to this scene. Or, uncheck the 
“Include” box to remove a setup from the scene. When the “Show All Available Setups” box is not checked, only those 
setups that are linked to this scene are included in the list.  
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Unlink Payoff – If a payoff has been linked to this setup, the chain link with the explosion will be displayed. Click the link 
to remove the link with the payoff. 

Link Payoff – If a payoff has not been 
linked to the setup, the chain link 
without the explosion will be 
displayed. Click the link and the Payoff 
selector window will be displayed. 
Click on a payoff in the list to link it to 
the setup. 

Jump To Payoff – If a payoff has been 
linked to the setup, a green arrow will 
be displayed. Click the green arrow to 
jump to the scene to which the payoff 
is linked. 

Add a New Setup – Click the Add 
button to add a brand new setup to 
this scene.  Another way to add a 
setup is to drag it from the Setups list in the Beats view and drop it anywhere on the Big Scene View. 

Delete a Setup – Select a setup in the list then click the Delete button to completely delete a setup. 

PAYOFFS 

The Payoffs section works just like the Setups section, so follow the instructions for the Setups section. 

CHARACTERS 

The Characters section lists the 
characters that have been linked to 
the scene and works very similar to 
the Setups and Payoffs. 

The list only shows the characters in 
the scene until you click the “Show All 
Characters” box. Then, all characters 
will be displayed. The description 
shown depends upon whether the 
character is included in the scene. If 
the character is not included in the 
scene, the description is the 
description from the master 
characters list. If the character is 
added to the scene, the generic 
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description will not be visible but is replaced with a description that you enter specifically for this scene. 

Just check the “In Scene” box next to the character to include the character in the scene. Or, uncheck the box to remove 
the character from the scene. 

Another way to add a character to the scene in this view is to drag it from the Characters list in the Beats section and 
drop it anywhere on the Big Scene View. 

ATTACHMENTS 

The Attachments section lists all attachments 
that have been linked to the scene. 

Again, click the “Show All Attachments” box 
to see all the available attachments from 
which you can select. Then click the 
“Attached” box next to an attachment to link 
it to the scene. Uncheck the “Attached” box 
to remove it from the scene. 

Another way to add an attachment to the 
scene is to drag it from the Notes section and 
drop it anywhere on the Big Scene View. 

The Description is similar to the Character 
description in that the generic description 
from the attachment will be displayed if the 
attachment has not been linked to the scene 
and, if the attachment is linked to the scene, you can modify the description to explain the importance of the 
attachment as it relates to this scene. 

Primary Display Image – If you have more than one attachment linked to the scene, you can designate one to use as the 
primary image.  

 

Click the “Make Primary” checkmark to make an attachment’s image the primary display image that will be displayed on 
the card when viewing it on The Board. 
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THE SCRIPT 

Here is where you can type the actual script for the scene. One note, however. Don’t type the scene heading. Use the 
scene heading box at the top of the scene card for that. Just type your action and dialogue here. Standard screenplay 
formatting is used here and cannot be changed. 

 

Action – Each new paragraph defaults to action which is formatted to start at the left margin. 

Dialogue – When the cursor is at the beginning of a new action paragraph, press Tab to change it to Dialogue. The cursor 
will move to the appropriate location for the character’s name. Type the name and press Enter to move to the 
appropriate position for the actual dialogue. 

 If you want to add a parenthetical, below the character’s name, just type the opening parenthesis as the first character 
and the paragraph will be reformatted for a parenthetical. Otherwise, type the dialogue and press Enter. 

Transition – To add a transition such as FADE OUT: or CUT TO:, press Tab while the cursor is in the character position. In 
other words, if you started at a new action paragraph, press Tab to move to the character name position, then press Tab 
again to move to the transition position. 

To remove an entire paragraph, either backspace from the end to erase all the text, then press backspace once more to 
remove the paragraph. Or, highlight all the text in the paragraph and press backspace once to erase it, then press it 
again to remove the paragraph. 

Although it may seem like it, the Script section is not a word processor. It performs the basic functions to type a properly 
formatted script so that you can get a good start on writing your screenplay. For custom formatting or other more 
advanced features, you will want to export your script to Final Draft and complete the process in Final Draft. 

You can view your entire script as you go by clicking the Reports menu then the Script menu. 

GREENLIGHT CHECKLIST 

The Greenlight Checklist provides you with a checklist of things to think about regarding your story to make sure you are 
ready to pitch it. For more information about the Greenlight Checklist, see the book Save the Cat! Strikes Back. 

As you work your way through the checklist, you can check the boxes for the items you have covered and, when you’ve 
checked them all, you are ready to go. 



 
                 Save the Cat!® Version 3.0 Windows User Guide 

Copyright ©2011 Blake Snyder Enterprises, LLC Page 34 
 

TRANSFERRING YOUR FILE 

There are two methods for transferring your file from one computer or device to another.  

SAVE THE CAT! CLOUD 

The Save the Cat! Cloud is a secure server on which you will have your own queue where your files will be held 
temporarily during the transfer process. 

TO YOUR CLOUD 

Sending your file to the Save the Cat! Cloud will place your file into your own personal queue from which you can 
download it to any device or computer. With a Save the Cat! 3.0 file open, click the File menu then the Transfer menu 
then the To My Save the Cat! Cloud menu. 

RETRIEVING FROM YOUR CLOUD 

To retrieve one or more files from your queue, click the File menu then the Retrieve from the Cloud menu. A list of the 
files in the queue will be displayed. 

 

Check the Download box for each file that you want to retrieve then click the appropriate button. Click the Download 
button if you want to download the selected files and leave them in the cloud or click the Download and Remove 
button to download them and delete them from the cloud. 

As each file is downloaded, you will be prompted to select the location where the file should be saved on your 
computer. 

IMPORTING FROM SAVE THE CAT! VERSION 1 OR 2 

To import a file, or convert a file from Save the Cat! Version 1 or 2 to Version 3, first you must export the screenplay 
from Version 1 or Version 2. Use the Export Screenplay for Windows Version menu and save the file to a folder.  

Then, in Save the Cat! Version 3, click the File menu, then the Import menu, then the Save the Cat! Version 1 or 2 – 
Windows menu. Select the file you just exported. Select a name and location for the new, Version 3 file, and Save the 
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Cat! will convert it to Version 3 format and save it to the selected location. If you have a lot of long descriptions and 
script, it could take a bit for it to convert so be patient. 

IMPORTING FROM FINAL DRAFT 8/9 

If you have a script that you have already written in Final Draft 8/9 but want to check out its structure in Save the Cat! 
3.0, you can import it. Save the Cat! 3.0 will identify the scenes and create a scene card for each one and place it onto 
The Board based on the page number. 

Before you can import a Final Draft 8/9 script, you must open the script in Final Draft and lock the pages. Locking the 
pages adds information to the file that Save the Cat! 3.0 uses to identify on which page a scene starts. You lock the 
pages by clicking the Production menu in Final Draft then the Lock Pages menu. You should actually repeat this process 
to also Lock “A” Pages. One note about page numbers: If the script was already in revision mode with the pages locked 
and changes were made to the script, there could be pages numbered something like “A2” or “2A.” Save the Cat! 3.0 will 
not recognize these types of page numbers. It is more concerned with the total number of physical pages and where 
scenes fall within those pages. And, therefore, which beat the scene is in. So, when the script is imported, the total 
physical pages will be determined and all page numbers will be translated to their physical page number. 

After locking the pages in Final Draft 8/9 and saving and closing the file, you are ready to import it. Click the File menu 
then the Import menu then the Final Draft 8/9 Script menu. You will be prompted to select the Final Draft file which will 
have an “fdx” extension. Next you will be prompted to select the location and enter the name for your new Save the 
Cat! 3.0 file. 

Upon saving, the script will be imported and the file opened for you to begin your review. 

EXPORT TO FINAL DRAFT 8/9 

After you have determined the scenes for your screenplay and perhaps even typed the script for each scene, you can 
export your screenplay to a Final Draft 8/9 file which you can then open in Final Draft 8/9 and polish up. Save the Cat! 
3.0 will export all your characters, locations, and scenes. Included for each scene will be the scene heading, scene 
description, and script. 

With your file open in Save the Cat! 3.0, click the File menu then the Export menu then the To Final Draft 8/9 menu. You 
will be prompted to select the location and verify the file name for the Final Draft 8/9 file. Upon saving, the file will be 
created and you are ready to open it in Final Draft 8/9. 

REPORTS 

The best thing to do to learn about all the reports is to try them out and see what happens. 
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